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USING ARCSERVER TO GIVE AN EXTREME MAKEOVER  

TO ONLINE MAPPING 
 
 
1. Overview 
 

The County Mapper is a web application that provides current geographic information 

and maps to citizens, businesses and County staff.  Since 1998, Prince William County GIS has 

given customers the ability to visualize geographic data online through this online mapping 

application. It has become an integral part of customer service and a foundational tool for both 

internal staff and the public and therefore, has gone through many changes over the past 12 years 

to adapt to new technologies, applications, customer types and business needs. 

In July 2010, Prince William County officially released County Mapper XM, an extreme 

makeover from prior County Mapper releases. Written in the latest ESRI ArcServer technology, 

County Mapper XM was a response to many Customer demands for a single, high powered web 

application that answered geographic questions from the very basic search capabilities to the 

more complex buffering and spatial queries. Anticipating transition anxiety from loyal users, GIS 

staff carefully planned and executed a successful strategy for a six month transition period 

complete with promotion, training classes, videos and brochures, and constant communication 

effort. The result of this effort was that the previous release of the application was quietly taken 

off line without any pushback from the user community.   

County Mapper XM serves the citizens, businesses and staff of Prince William County 

and receives approximately 46,000 hits monthly from internal and external customers. It can be 

accessed by visiting the URL www.pwcgov.org/Countymapper. 
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2. The Problem/Challenge 

For more than 10 years, the County Mapper application has been a steadfast tool for 

Customers to view geographic information about Prince William County. As the application 

grew in popularity and users became more confident with its abilities, there was strong and 

steady feedback about what was wanted and needed from the application. Both internal and 

external Customers desired a single application to see necessary data in order to do County 

business. They wanted the data layers organized in a logical manner to avoid having to scroll and 

search through a long list to find what was needed. 

From 2003 through 2008, Prince William County’s County Mapper application used the 

ESRI ArcIMS technology. This application allowed users to view GIS and County Assessment 

information from a single interface; however, there were many drawbacks.  The ArcIMS 

technology was quickly aging. Although its main purpose is to deliver simple, well-defined maps 

over the internet, the upcoming ArcServer technology offered a full range of GIS editing and 

more complex mapping services on the web. As new data layers were developed, users 

demanded that this data be available online. Providing access to upwards of 44 data layers came 

with a performance cost as each action, query or request required the map frame to be redrawn.  

The map legend displayed layers in a list which could not be maintained in alphabetical order 

without mass programming code being altered each time a new layer was added. This required 

customers to scroll through a long list to search for the layer they needed to access.  

An issue facing the County’s GIS staff was the demand for a single interface to serve 

multiple customers, who each held different requirements. The need for information and the 

associated skill level of users ranged from the very basic for the general citizen to the more 

complex for internal staff.  Performing multiple layer queries was desired to help reduce the time 
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and effort in gathering large amounts of information about properties. The more technically 

savvy users began integrating copies of the maps produced by County Mapper as part of their 

reports and communications. Customers began asking for methods of tracking and identifying 

information specific to their project or properties on County Mapper. 

As technology improved/migrated/???, there was a higher customer demand for geographic 

information to be available in real time and to have its’ presentation appear seamless to the end 

user. Underlying database tables were only being updated on a weekly basis and were reliant on 

nightly scripts to transfer data from enterprise databases to the IMS servers. This was seen as a 

single point of failure. 

 
3. Implementation 

 
With the underlying technology changes that had become available for online mapping 

systems, serving geographic information went through significant changes and improvements. 

Prince William County GIS Developers felt that this was the perfect time to incorporate many of 

the suggestions and requests for enhancements that had been received over the years from 

faithful users. These changes included faster performance, complex queries, a larger map canvas 

and more simplistic interface. 

GIS staff performed extensive research for best practices with the current ESRI ArcServer 

technology and began development in February 2009. Using ArcServer 9.3.1 and the Javascript 

API, both the internal/external interfaces went through a dramatic change. The user interface 

incorporated multiple ways to navigate using slider bars, rubber banding, overview maps, and 

directional arrows similar to those found in Google Maps.  Developers were able to increase the 

size of the map canvas up to 30% by relocating the data layer window to a tabular dropdown 

menu where layers were grouped based on their business use for optimal organization. 
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Displaying data was made easier as layers could be turned on and off simply by checking a box 

which did not require the entire map to be redrawn as in previous releases.  GIS staff took 

advantage of map caching services to improve performance when drawing and querying data a 

more rapid response to panning and zooming. Finally, the addition of a tool that gave the ability 

to set the transparency level offered more powerful visual analysis as multiple polygon layers 

could be viewed simultaneously.  

 Additional improvements in functionality were made when identifying property and layer 

information. Previously, users could only display information from a single layer. With County 

Mapper XM, the Identify tool allowed users to select and return information from multiple layers 

in a single query.  Keeping time saving in mind, developers also added a handy new tool under 

the Map Tools tab. The Show Parcel Info tool let users display a property’s GPIN and address 

information in a call out box just by placing the cursor over a property, similar to a tool tip.  

While much of the search functionality remained the same, County Mapper XM provided 

quick and easy access to Prince William County geographic data that can be critical to business 

decisions. The application provides URL links to multiple databases and applications within the 

County such as LandRover, Parcel History Tree, FEMA documentation and land development 

information, where applicable. Its flexible interface offers the user the ability to save custom 

extents and layers; add printable text and graphics to create dynamic maps and pass information 

to Google Street view and Driving Directions. 

County Mapper XM was released as beta for internal staff in Sept 2009. County employees 

who were regular users of the system were encouraged to provide comments while modifications 

continued and network security strategies were implemented for public release. With all 

feedback incorporated, County Mapper XM was officially released to the public in July 2010. A 
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conscious decision was made to run both the ArcIMS and the ArcServer versions of County 

Mapper for a period of 6 months, giving users plenty of time to get used to the new release 

before the ArcIMS version was shut down. The goal was to have the previous release turned off 

by January 2011 and have it go quietly away without interruption to the GIS user community. 

Prince William County GIS staff kicked off the release of County Mapper XM by placing 

announcements on the department’s internet webpage, creating a promotion segment on the 

County’s cable news show and displaying announcements on multimedia boards.  Serving as the 

feature article in the County’s Development Community newsletter, The Alliance, helped to 

introduce County Mapper XM to a large customer base. 

 Recognizing that transition may be difficult for some, training classes for both internal 

staff and the public were created and offered. There were eight 2-hour training sessions held and 

more than three hundred attendees, seventy-eight of who were public citizens and/or members of 

the business community. These seminars were held twice a month over a four month period and 

contained not only a demonstration but handouts to include a “Survival Guide” with tips and 

tricks, help documentation and a FAQ page. All of these training materials were also 

downloadable from the web. Private tutorial sessions were also held at the request of some large 

companies, professional organizations and VIP users. After the initial four month training period, 

Prince William County Communications Department helped GIS staff to create several YouTube 

training videos for new users and refresher sessions. 

The ESRI Javascript API lacked some of the printing capabilities that existed inherently with 

ArcIMS. Not wanting to take functionality away, Prince William County hired ESRI to develop 

some custom code for cut/paste functionality and enhanced printing capabilities. This included 
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PDF creation, custom printing of graphics and page layout, as well as cut and paste ability. 

 

4. Financing and Staffing 

Environmental Systems Research Institute (ESRI) is the County’s GIS software vendor and is 

the industry leader for serving maps and geographic information on the web. Their COTS did not 

provide all of the desired functionality and display capabilities that were being requested by 

users. Prince William County used an in-house GIS Application Developer to create, test, debug 

and deploy the custom application with assistance from ESRI Professional Services to perform 

coding for complex printing solutions. No additional hardware or software purchases were 

required. Prince William County’s GIS Database Administrator had previous training experience 

and was asked to create training and marketing materials.  The cost breakdown is as follows: 

• GIS Application Developers – $67,500  

o 32 weeks of design and development - 75% of time dedicated to project 
o 7 wks of enhancement design, development deployment, 50% time dedicated.  

 
• GIS Database Administrator – $5,700   

o Marketing and training 
o 13 classes at 3 hours a piece 
o 16 hours for training material development 
o 8 hours for video preparation and development 

 
• ESRI Contractor - $23,000 for 120 hours 

 
5. Program Results 
 
County Staff and the Public have been using County Mapper XM for almost a year.  The 

transition has been smooth and straightforward. The largest issue faced by GIS staff was 

introducing long time users to the new system. As with all new technology, there can be some 

apprehension of change even when the process has been improved. Prince William County 
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recognized that there was a learning curve and the training sessions helped to increase their skills 

and ease of use. On January 3, 2011, six months after County Mapper XM went public; the 

previous release of County Mapper was quietly taken offline without any pushback from the user 

community. 

With the Extreme Makeover of the County Mapper application, individuals and 

organizations now have access to powerful analysis tools, a familiar and flexible user interface 

and improved performance.  It is one stop mapping that provides visibility and creditability to 

Prince William County and the business decisions that are made with this interactive tool. 

 
6. Award Criteria 
 

Prince William County is a model for other jurisdictions that wish to reduce the 

maintenance of multiple applications and help answer many questions in a single, one-stop spot. 

GIS staff listened carefully to needs of their diverse Customer base and leveraged technology to 

create an innovative way to deliver online mapping services. The amount of information 

available and the complexity of the underlying functionality appear seamlessly within a 

simplistic interface. 

Prince William County Citizens, businesses and staff have become highly dependent on 

County Mapper XM in the course of their daily routine. It has enhanced the creditability and 

usability of GIS data and County business decisions and is depended upon as one of the most 

efficient, easy and cost effective means to access geographic information that is necessary for 

community development, human services, public safety and the general government.   
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Previous release of County 
Mapper had limitations to 
the layer display, query 
options and map canvas 
size 

County Mapper XM 
maximizes the screen space 
through use of tabs and 
dropdown menus 

Layers and Tools 
are organized in 
tabs based on 
logical business 
use. 
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Public facing web page keeps 
users informed about County 
Mapper XM. Links appear for 
rapid access to training 
videos on Youtube.com, help 
documentation and FAQs. 
 

The Parcel Info Tool gives 
users a quick and easy way 
to display GPIN and 
Address information 
without performing a full 
parcel query. 
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Giving the user the ability 
to annotate maps, the 
custom drawing tool adds 
value by allowing the user 
to add graphics to their 
map display and print 
result. 
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Users can access a large variety of information 
about a single property with a single query. The 
application offers multiple ways to query 
geographic locations. 
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The Identify Tool allows 
for users to spatially select 
multiple layers to return 
data attribution within 
seconds. 



 
 

This document will give users quick reference to using County Mapper XM. For 
complete detail, users should reference the Help Document within the County 

Mapper application or search our County Mapper FAQ page. 
 
 
QUERYING AND ACCESSING  DATA AND LAYERS 
 
Tip: To open the Layers or Map Tools Menus, simply click on the title to open the dropdown 
box. To hide the menu again, click on the menu title again. Users can also click off the menu 
in the map canvas to hide the box but be careful!! If you have an active tool, such as zoom, the 
map will react to that active tool. 
 
Tip: Show Parcel Info gives you parcel/address in a 
tool tip window. To turn it on click the Map Tools 
dropdown menu and select Show Parcel Info.  Roll your 
cursor over the parcel to have the information displayed. 
To turn off this feature, go back to Map Tools 
dropdown and select Clear Parcel Info. 
 
 
 

Tip:  Use QUICK SEARCH to display parcel 
data in the most organized fashion. Parcels can be 
searched by GPIN number or Address. Using this 
feature is where the MORE INFO button and 
TAX INFO button will be shown. 
 
 
Tip:  If you search on an address under the 
parcel tab and it returns no results, try searching 
under the premise address. Premise addresses are 
used when there are multi-tenant spaces, typically 
with unit numbers assigned. 

 
 
Tip: Only search using Premise Address when you are searching for a multi-tenant 
property such as commercial space or apartment complexes. Not ideal for searching parcels and 
does not contain links to other databases 
 



Tip:  Results tab is where information is displayed about the 
GPIN or address entered.  Several buttons offer additional 
information. These buttons are only accessible from the 
Quick Search  
 

ADJOINERS display the owners name and address for 
any property that touches the property queried. 

 
TAX INFO links to the Real Estate Assessments site to 
display further tax information. 

 
MORE INFO button gives tons of additional 
information about a property. It is only accessible when 
searching for parcel from thru Quick Search. 

 
 
Tip: To view Elevation Certificates or FEMA letters of Map 
Amendments, the user must click on MORE INFO. If an 
elevation certificate exists then a link will be visible. If no link is 
visible, then PWC does not have the certificate. 
 
 

 
 
 
 
 
 
 
 
Tip: Layers are organized by business use. Just 
check the box to turn a layer on or off. Gray box 
means you need to zoom in more before layer 
becomes available. 
 
 

Tip: Use the Transparency Tool to lighten shading on shaded polygon layer. Transparency 
tool only controls the shading for that individual tab. Each tab may have different levels of 
transparency for a customized look. 

 
 

 
 



PRINTING 
 
Tip: Printing can be tricky!           Use the printer icon to do 
ALL printing to print, click on the printer icon. Users can decide 
if they wish to add a title, print search results or the legend by 
checking boxes or click on Print Preview. You must have the 
legend loaded or have feature results present to select these 
options. Remember to turn off your popup blockers!! If printing is attempted without going 
through the printer icon, map image will appear incomplete when printed. 

 
 

Tip: Printing to PDF requires that the user have Adobe Professional or a 3rd party PDF 
converter (e.g. PrimoPDF) installed on their machine. Depending on the user’s security settings 
with their internet browser, printing to PDF with Adobe may cause errors. If this occurs, users 
should use the alternative PDF converter.  
 

 
 

Tip: To get optimal page size 
when printing. From Printing 
Layout window, go to File>Print 
Preview and change printer 
settings to landscape. If you 
cannot see the image, change the 
view to 90%. These options may 
be different depending on your 
personal printer settings. 
 
 
 
 

 
 
Tip: To cut and paste the map image you MUST print 
to PDF first. Open the PDF and under Tools>Select & 
Zoom select the SnapShot Tool. Define the area to copy 
(make sure to include the disclaimer!). The tool 
automatically copies the selected area and can be pasted 
into email or other document formats. 

 
 
Tip: The references for the Legend only stays active for approximately 10 minutes after the 
legend is loaded. When the reference has been lost, the user will see a white box with a red X 
where the legend symbol would be. Avoid loading legend until you are ready to print, 
otherwise users must completely exit the application and re-enter to rebuild the legend links.  



IDENTIFYING LAYER INFORAMTION 
 

Tip: Use IDENTIFY Tool          to get information 
about data layers other than parcels. You MUST have 
the layer turned on in the Layers menu for it to show 
up in the list of layers available for identifying. 
 
Tip:  Always work menu boxes from TOP to 
BOTTOM. Don’t do step 2 before you do step 1. 

 
Tip:  Tool Menus do not minimize but can be moved 
around by click on the gray area at the top of the bar. 
Remember, if you close the box, you close the tool! 
 
Tip:  Information displayed from Identify Tool is 
pulling information from within the actual GIS layer. 
It is not formatted with additional information from other 
databases. Parcel information is best displayed when 
property is searched and displayed under QUICK 
SEARCH. 

 
 
TOOLS AND SETTINGS 
 
Tip: Current Tool tells which tool is currently active and will happen when you click the map 
document window. Keyboard means control is the mouse 

 
Tip: When using the Measure Tool, remember to CLICK ONCE to start drawing 
and CLICK TWICE to end the drawing. Measurement will be displayed when the line has 
been completed. A single click will also allow you to change direction at corners. 
 
 
Tip: When drawing graphics with the redline tool         , select 
button first and then set size and color before adding the graphic. 
Text is added with single click, lines start with a single click and 
end with a double click. Transparency needs to be set prior to 
drawing a polygon graphic.  The trashcan       clears all graphics and 
the undo          clears the last graphic. 

 
 
 
Tip: To avoid oversized dialog boxes, Screen resolution should 
be set to 1280x1024  



FAQs about GIS Web Applications 
 
 
COUNTY MAPPER XM 
Why is the old version of County Mapper going away? 
How much longer will the old version still be available to use? 
Why do I have to print from through the printer icon? Why can’t I just go to File>Print? 
Why can’t I control the zoom in and out at very small intervals? 
Will I get the same results if I search by Premise Address versus Parcel Address? 
Why doesn’t the Identify button display results for parcels in a formatted layout like the 
old version of County Mapper? 
Why does the image not print out? 
Why can’t I keep my saved settings under MyMap? 
I can’t get the measure tool to draw anything? 
Why doesn’t my layer show up in the list when using Identify? 
Do I have to enter a title when printing? 
What happened to the Legend with all the symbols? 
How can I cut and paste the map into an email or document? 
How do I link to the Real Estate Assessments data? 
How do I find Adjoiner information for my property? 
What does the More Info button do? 
Why are the dialog boxes so big and I must use the scroll bars for viewing? 
Why does the map react if I just simply click on it? I didn’t tell it to do anything. 
Why do I see a blank document when I look at print preview? 
How can I find the location of different data layers? 
How do I use the transparency tool bar? 
Why can I not change the transparency for aerial imagery? 
What does that big red X mean? 
What is the parcel history tree link about? 
How come I cannot change the transparency on a shaded graphic that I just added with 
the redlining tool? 
How do I unselect features or clear the highlights on a property? 
How do I search for a subdivision? 
Why do I need to copy the disclaimer when cutting and pasting images into emails and 
documents? 
Why does printing results with scroll give me problems? 
My question isn’t shown on the list 
 
 
 
 
Why is the old version of County Mapper going away? 
Because the underlying technology used to build the previous online mapping system has gone through 
significant changes and improvements, the computer hardware and software used to provide the previous 
version will no long be available or supported by our software vendor.  
 



How much longer will the old version still be available to use? 
The previous release of County Mapper will be available to use until January 1, 2011. 
 
Why do I have to print from through the printer icon? Why can’t I just go to 
File>Print? 
Because the image that you are viewing from the initial PWC Mapper window is actually referring a virtual 
image on the server, you must go through the printer icon to “capture” the image. On the printing 
dropdown box, select Print Preview and you will be taken to a Printing: Layout Page. If this page fails to 
appear, make sure that you have allowed for popup from our site. From the Printing: Layout Page your map 
is now available for printing. If you do not go through the printer icon to the layout page and print from the 
PWC Mapper window, there will be missing data on your printed page. 
 
Why can’t I control the zoom in and out at very small intervals? 
To improve performance, data layers are “cached” for faster data retrieval. Caches are built at set scales and 
cannot be dynamic. When users zoom in or out, the zoom level will adjust to the closest cached scale. Scale 
caches are built at 1:300, 1:600, 1:1200, 1:2400, 1:4800, 1:9600, 1:19200, 1:38400, 1:76800, 1:153600, 
1:307200 with a relative scale range of 20 feet to 4 miles.  
 
Will I get the same results if I search by Premise Address versus Parcel Address? 
No. Premise Address and Parcel Address searches are very different.  Links for Adjoiners/More Info/Tax 
Info are not available for premise address searches. These options are only available on parcel address or 
GPIN searches. That is because premise addresses are associate to a POINT rather than an AREA, which is 
the case with parcel.  
 
Parcel addresses are assigned to a single piece of land. Premise addresses are assigned to buildings and/or 
units that are located on parcel of land. In cases where the parcel of land contains a single structure that is 
owner-occupied, the parcel address and the premise address will be the same. In cases where many 
structures are located on the same parcel (e.g. apartments or business complexes), the premise address will 
be different than the parcel address.  It is recommended to always search by parcel address first and then 
search by premise address. 
 
Why doesn’t the Identify button display results for parcels in a formatted layout 
like the old version of County Mapper? 
Because County Mapper XM gives the user the ability to identify multiple layers, formatting must be 
generic to account for the variety of information displayed. The information displayed through the identify 
tool is displayed as it exists in the raw GIS data. This method allows for users to view all feature attributes. 
If a user wishes to view the details of a single property, it is recommended to use the Quick Search 
Function. 
 
Why does the image not print out? 
Because the image that you are viewing from the initial PWC Mapper window is actually referring a virtual 
image on the server, you must go through the printer icon to “capture” the image. On the printing 
dropdown box, select Print Preview and you will be taken to a Printing: Layout Page. If this page fails to 
appear, make sure that you have allowed for popup from our site. From the Printing: Layout Page your map 
is now available for printing. If you do not go through the printer icon to the layout page and print from the 
PWC Mapper window, there will be missing data on your printed page. 
 
Why can’t I keep my saved settings under MyMap? 
Saving extents and layers under MyMap requires that the user’s internet browser accepts “cookies”.  If a 
cookie is removed, then the saved extent is also removed.  Failure to save extents are typically a result of 
when the internet browser setting is turned off for accepting cookies or the user cleans out the temporary 
internet files nightly. 
 



I can’t get the measure tool to draw anything? 
When using the measure tool, users should use a SINGLE click to start a line or change direction of a line 
and should use a DOUBLE click to end the line. If a user double clicks to start a line, the tool interprets that 
as the start and stop point being the same location and nothing will be drawn on the screen. 
 
Why doesn’t my layer show up in the list when using Identify? 
For a layer to show up in the Identify layer list, it must be turned on and visible. Go to the Layers tab and 
verify that the box is check. If not, check the box to turn the layer on, go back to the Identify dialog box 
and click Update List. The layer should now be shown in the list. 
 
Do I have to enter a title when printing? 
No, entering a title is optional. You are also not required to print Results or the Legend. However, if you 
wish to print the Results you must a feature selected and information displayed in the Results Tab, 
otherwise this checkbox will not be available to be selected. The Legend must be loaded for this option to 
be available. Users can load the legend by clicking on the Legend tab and selecting Load.  
 
What happened to the Legend with all the symbols? Why can I see it? 
To increase performance, the legend is not loaded by default. A user has the option of turning the legend on 
by clicking on the Legend tab on the right side of the screen and clicking the Load Legend button. Once the 
legend is loaded, it becomes available for printing and will update dynamically as layers are turning on and 
off. 
 
How can I cut and paste the map into an email or document? 
The cut and paste functionality is not inherent to the County Mapper XM printing functionality. GIS is 
working to improve this, however, a workaround can be used with the following methodology: 

1. Print map as PDF 
2. Open PDF in viewer 
3. In PDF viewer, select Tools>Select & Zoom> Snapshot Tool 
4. Use snapshot tool to define area to copy (don’t forget the disclaimer!) 
5. Snapshot tool automatically copies to clipboard 
6. Go to email or file document and select Paste 

 
How do I link to the Real Estate Assessments data? 
Links to the Real Estate Assessments data are only available when searching a parcel. A link can be found 
when using the Identify tool on the parcel layer. The Tax Info button that is shown in the Results tab when 
locating a parcel with Quick Search will also provide this information. When activating the link, a new 
window will popup and users will be taken to the Land Rover application. Please ensure that popup 
blockers are turned off to use this feature. 
 
How do I find Adjoiner information for my property? 
Adjoiner information is only available when searching for a Parcel using Quick Search. When selecting the 
Adjoiner button, links will appear in the Results tab that display the Owner and Address information of all 
properties that TOUCH the selected parcel. Users may hover their mouse of the word HIGHLIGHT to 
show which parcel the link belongs to on the map. 
 
What does the More Info button do? 
The More Info button does just that – provide more information about the selected property. It is only 
available when a parcel is searched using Quick Search. More Info displays school district information, 
voting district information, subdivision and environmental information, as well as links to other databases 
if available. 
 
 



Why are the dialog boxes so big and I must use the scroll bars for viewing? 
County Mapper XM was designed to be displayed using the standard computer resolution of 1280x1024, 
therefore, that is the optimal resolution setting recommended. If a user has a smaller setting to display 
larger icons, the dialog boxes will be enlarged with scroll bars.  
 
Why does the map react if I just simply click on it? I didn’t tell it to do anything. 
When a user clicks on the map canvas (map image) and it does something unexpected, always check the 
Current Tool on the County Mapper XM toolbar to see which tool is active. Often time a user will 
unknowingly have the zoom tool active. To deactive any tool and return control back to the mouse, click 
the red X located on the County Mapper XM toolbar next to the Pan tool. 
 
Why do I see a blank document when I look at print preview in landscape? 
Depending on the user’s personal printer settings and paper margins, some users may have to change their 
page size to 90% to allow for the entire image to print out. 
 
How can I find the location of different data layers to turn them on and off? 
Data layers are listed under the Layers Menu and are organized based on their business use. There are 9 
“tabs” or categories that are shown in the dropdown menu. Each tab has a collection of layers associated 
with that category. Next to each layer name, a box can be checked to turn the layer’s visibility on or off. 
 
How do I use the transparency tool bar? 
The transparency tool bar controls the shading level of a layer on the map. The shading can be made 
heavier or lighter by sliding the transparency bar.  The transparency only controls all the layers within that 
tab but is independent from other tabs. For example, transparency levels can be made heavy for Land 
Development and very light for Environmental. This allows the user to customize the map appearance to 
their individual need. 
 
Why can I not change the transparency for aerial imagery? 
Aerial imagery is the always the base layer in which all other layers are overlaid. Think of it as the bottom 
piece of bread in a sandwich. It cannot be made transparent because there is nothing underneath the aerial 
imagery to view. 
 
What does that big red X mean? 
The red X is the deactive button. It restores the selection tools back to the default settings and returns the 
control to the computer mouse.  
 
What is the parcel history tree link about? 
The parcel history tree application is a tool that quickly displays the parent-child relationship for a GPIN. It 
is meant as a tool and guideline to assist in parcel research, however, it is not all inclusive prior to the year 
2000 and does not provide lineage for properties created prior to 1994 when the GPIN numbers were first 
established.  
 
How come I cannot change the transparency on a shaded graphic that I just added 
with the redlining tool? 
Users must set the transparency level prior to drawing the shaded graphic. Once the graphic has been 
drawn, the transparency level cannot be changed. 
 
How do I unselect features or clear the highlights on a property? 
There are two ways to clear the highlight.  In the Results tab, click the Clear Results button or under Map 
Tools menu, select Clear Search Graphics. 
 



 
How do I search for a subdivision? 
Users can locate subdivision by clicking on Quick Search and select the Features Tab. In the dropdown box 
under Select Layer, select Subdivisions. Subdivision names can be selected through the Select Options 
dropdown box or the user may begin typing in the subdivision name. The Select Options box will narrow 
the results as the user types the desired name. 
 
Why do I need to copy the disclaimer when cutting and pasting images into emails 
and documents? 
Prince William County asks that when using a PWC map, either paper or electronically, to present the 
image with the disclaimer attached to avoid confusion or misrepresentation and ensure that the recipient 
understands that it is for display purposes only and is not to be used or construed as a legal instrument.  
 
Results don’t fully print when I have multiple features selected. What’s with the 
scroll bar and where is my information? 
This is a bug in the printing functionality with County Mapper XM. Prince William County GIS 
Developers are working to resolve the issue. There is no workaround at this time. 
 
My question isn’t shown on the list 
If your question is not shown in the FAQs, please contact GIS staff at 703-792-6840 or email 
pwcmaps@pwcgov.org with your comments or questions. 
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